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論理合成

第 6 章 　 論理合成

　 本章では Lattice Diamond での論理合成の実行方法や、 ス ト ラ テジ （Strategy） および設計制約の設定方法 
等について記述し ます。

6.1 論理合成ツール

　 Lattice Diamond では論理合成ツール と し て Synplify Pro と Lattice Synthesis Engine （以下 LSE） が使用でき    
ます。Lattice Diamond 2.1 以降のバージ ョ ンでは、LSE が MachXO シ リ ーズ （MachXO, MachXO2, MachXO3L）    
のデフ ォル ト と なっています。 LSE は、 バージ ョ ン 3.3 時点でこれ以外のフ ァ ミ リ には対応し ていません。

　 LSE を使用し た場合は、 論理合成と一緒に [Translate Design] プロセス相当の処理も同時に実行されます。

　 なお、 Diamond 2.1 および 2.2 からはス ト ラテジ設定オプシ ョ ンの幾つかが新規追加、 またはデフ ォル ト 指 
定の変更が行われていますので、 旧バージ ョ ンからのア ッ プデー ト で同一プロ ジェ ク ト を作業する場合、 留
意し て く ださい。

6.1.1 使用する論理合成ツールの選択

　 論理合成ツールを選択するには、まず Lattice Diamond の メ ニューバーから [Project] => [Active Implementa-     
tion] => [Select Synthesis Tool] を選択し ます （図 6-1）。

図 6-1. 論理合成ツールの選択

　 表示される図 6-2 のよ う な Project Properties ウ ィ ン ド ウで Name 欄 Synthesis Tool 項に （デフ ォル ト で） 選   
択されている論理合成ツールが Value 欄に表示されています。Value 欄のど こかを ク リ ッ ク数と プルダウ ン形
式で選択可能なツール名が表示されます。 個々の例では Synplify Pro と LSE です。 所望のツールを選択後、 
OK ボタ ンを ク リ ッ ク し ます。選択し たフ ァ ミ リ に対し て選択でき る ツールのみが候補と し て表示されます。

　 或いは、 プロジェ ク ト やイ ンプ リ メ ンテーシ ョ ン生成後に変更する こ と も可能です。 二通 り の方法があ り
ます。 第一の方法は図 6-3 の よ う に イ ンプ リ メ ン テーシ ョ ン名を選択後右 ク リ ッ ク し、 [Select Synthesis  
Tool...] を選びます。第二の方法は同様にイ ンプ リ メ ンテーシ ョ ンを右ク リ ッ ク後 [Properties] を選択し ます。
いずれも図 6-2 とおな じプロパテ ィ ・ ウ ィ ン ド ウが表示されますので、 選択し直し ます。
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図 6-2. 論理合成ツールの選択 （プロパテ ィ ・ ウ ィ ン ド ウ）

図 6-3. 論理合成ツールの設定変更

6.1.2 バン ド ル版以外のツールを使用する場合の設定

　 論理合成ツールの実行パス設定を行 う こ と で、 Lattice Diamond にバン ド ルされている論理合成ツール以外 
や別バージ ョ ンの Synplify Pro を使用でき ます。Lattice Diamond の メ ニューバーから [Tools] => [Options...] を     
選択する と オプシ ョ ン設定ウ イ ン ド ウが起動し ます （図 6-4）。 ウ イ ン ド ウ左側のパネルで [Environment] =>  
[Directories] を選択する と、 右側はパス設定入力表示にな り ます。 ウ イ ン ド ウ上部に Synplify Pro と Precision 
のパス設定欄が用意されています。

　 Synplify Pro のパス設定は、 デフ ォル ト ではバン ド ル版のパスが設定されています。 Precision のパス設定欄 
はデフ ォル ト ではブラ ン ク になっています。 必要に応じ て これらのパス設定を変更し ます。 Lattice Diamond 
にバン ド ルされている Synplify Pro を選択し た場合、ウ イ ン ド ウ右上の [use OEM] のチェ ッ クは外さ ないで く   
ださい。 これ以外の Synplify Pro の場合は、 [use OEM] のチェ ッ ク を外し て く ださい。

右クリック
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図 6-4. Lattice Diamond のオプシ ョ ン設定ウ イ ン ド ウ ～ ツールのパス設定

6.1.3 LSE を使用する際の留意事項

　 LSE にはサポー ト するデバイ ス フ ァ ミ リ に制限があ り 、Lattice Diamond 3.3 までは MaxhXO シ リ ーズ （XO,  
XO2, XO3L） のみが対象です。 これら以外のフ ァ ミ リ は 3.4 以降順次正式サポー ト し ていき ます。 ECP5 は 
バージ ョ ン 3.4 からです。

6.2 LSE

6.2.1 ス ト ラ テジ設定ウ イ ン ド ウ

　 LSE のス ト ラ テジ ・ オプシ ョ ンについて記述し ます。

　 プロジェ ク ト ・ ナビゲータ左上に配置されている File List ウ イ ン ド ウに、 Project にイ ンポー ト されている 
ス ト ラ テジの一覧が表示されています。複数あ る中の太字表示が、 イ ンプ リ メ ンテーシ ョ ンに適用されます。
ス ト ラ テジ名をダブルク リ ッ クする と、 ス ト ラ テジ設定ウ イ ン ド ウが開き ます。

　 論理合成ツール と し て LSE を指定し ていれば、 ス ト ラ テジ設定ウ ィ ン ド ウ を立ち上げた場合に、 図 6-5 の 
よ う に 『LSE』 がすで選択されています。
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図 6-5. LSE のス ト ラ テジ設定ウ ィ ン ド ウ

6.2.2 LSE ス ト ラ テジ ・ オプシ ョ ンの詳細

　 以下にス ト ラ テジ ・ オプシ ョ ン各設定の詳細を説明し ます。

Carry Chain Length

パラ メ ータ : 数値 デフ ォル ト 値 : 0

演算回路を イ ンプ リ する際に使用される桁上が り ／桁下が り 伝播専用配線であ る Carry Chain の使用 
を制限するためのオプシ ョ ンです。

設定値は、 SLICE が桁上が り ／桁下が り を使用するモード で実現するデータの最大 bit 幅の許容値で
す。 最大で （設定値 + 1） までのカ ウ ン タや演算回路が Carry Chain を使用し て実現されます （1 ビ ッ   
ト 目は桁上が り が必要ないため、 この設定の対象にな ら ない）。[0] は 0bit ではな く 無制限であ る こ と
を表し ます。

なお、 この設定は [Use Carry Chain] オプシ ョ ンが [True] 設定の場合のみ有効にな り ます。

図 6-6. Carry Chain を使用し た SLICE 間接続

Carry Chain
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Command Line Options

パラ メ ータ : 文字列 デフ ォル ト 値 : ブラ ン ク

この ド キ ュ メ ン ト で紹介し ている GUI の リ ス ト に表示されていない特別なオプシ ョ ンを使用する場
合に、 直接引数等を記述し ます。

Disable Distributed RAM

パラ メ ータ : True ／ False デフ ォル ト 値 : False （Diamond 3.2 から追加）

[True] の場合、 RTL 記述から推論し て メ モ リ を使用し た回路を生成する際に分散 メ モ リ （Distributed
Memoy） を使用せず EBR を用います。

EBR Utilization

パラ メ ータ : 数値 デフ ォル ト 値 : 100

RTL 記述から推論し て EBR を使用し た回路を生成する際に、 ターゲ ッ ト とする EBR の使用率の上限
を設定し ます。 設定し た上限を超えた場合、 残 り はレジス タか分散 メ モ リ （Distributed Memoy） で実 
現されます。 IPexpress で生成し た EBR の RTL ソース を使用し た場合は、 このオプシ ョ ンの適用外で
す （全て EBR で実現されます）。

FSM Encoding Style

パラ メ ータ : Auto ／ One-hot ／ Gray ／ Sequential デフ ォル ト 値 　 Auto

VHDL の列挙 （enum） 型変数が定義されている場合、 その変換形式に関する設定です。 Auto （デフ ォ
ル ト ） の場合は、 ステー ト 数等から適当な構成のステー ト マシンが構成されます。 Auto 以外を選択
し た場合は、 それに沿った構成のステー ト マシンが構成されます。

Fix Gated Clocks （Diamond 3.2 から追加）

パラ メ ータ : True ／ False デフ ォル ト 値 : True

ソース内で ク ロ ッ ク ゲーテ ィ ング し ている ク ロ ッ ク信号を実装に適する構成に変換し ます。 対象ク
ロ ッ クは .ldc フ ァ イルに明記されている必要があ り ます。ゲーテ ィ ング制御用の信号には特定の要件
があ り ます。

変換された ク ロ ッ ク と関連する レジス タ情報はロ グフ ァ イル 『synthesis.log』 に書き出されます。

Force GSR

パラ メ ータ : Auto ／ Yes ／ No デフ ォル ト 値 : Auto

論理合成時の GSR （Global Set/Reset） 挿入に関する設定です。

[Auto] ／ [Yes] を選択し た場合は自動的に GSR バッ フ ァが挿入されます （ただし、 Set/Reset の構成
が条件を満た し た場合のみ）。 [No] を選択し た場合は GSR が使用されません。

GSR はマ ッ ピング （Map Design） プロセスでよ り 最適な条件で挿入する こ と ができ ます。 特別な理由 
のない限 り このオプシ ョ ンは [No] を選択する こ と を推奨し ます。

Hardware Evaluation

パラ メ ータ :  Enable ／ Disable 　 　 デフ ォル ト 値 : Enable

IP コ アの評価に関する設定です。 IP コ アを ラ イセン スな しで評価する場合は [Enable] （デフ ォル ト ）
を選択し ます。 IP ラ イセン スの入手後の設定はどち らでもかまいません。

Intermediate File Dump

パラ メ ータ :  True ／ False 　 　 デフ ォル ト 値 : False

暗号化されたフ ァ イル出力可否の設定です。 [False] （デフ ォル ト ） ではフ ァ イルは出力されません。

[True] を設定する と、 edif の他に暗号化された Verilog HDL ソース フ ァ イルでも出力されます。 出力 
される フ ァ イルの拡張子は [.ve] です。
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　 *****--------------------
• ト ラブル対応の際などにこの暗号化されたフ ァ イルを渡せば、 HDL ソース フ ァ イルから論理記述を読
み取られる心配がな く な り ます

　 *****--------------------

Loop Limit （Diamond 3.2 から追加）

パラ メ ータ : 数値 デフ ォル ト 値 : 1950

RTL ソース記述内で用いられる ”for” や ”while” ループ回数の最大値を与えます。 イ ンデッ ク スが変
数と し て与え られている場合にのみ適用され、定数の場合は適用されません。余 り 大きい値を指定す
る と、 ス タ ッ ク オーバーフ ローを生じ る可能性があ るので、 注意し ます。

MUX Style

パラ メ ータ :  Auto ／ L6Mux Multiple ／ L6Mux Single ／ PFU MUX 　 デフ ォル ト 値 : Auto

SLICE 内部のマルチプレ クサの使用方針に関する設定です。 [Auto] （デフ ォル ト ） では LSE が最適と
判断し たマルチプレ クサが使用されます。

[L6Mux Multiple] を選択し た場合は、 SLICE 内の [L6Mux] （図 6-7 ①） を優先的にカスケード接続し  
て使用し ます。

[L6Mux Single] を選択し た場合は、SLICE 内の [L6Mux] （図 6-7 ①） を優先的に使用し ますが、[L6Mux]  
のカ スケード接続は行われません。

[PFU Mux] を選択し た場合は、 SLICE 内の [PFU Mux] （図 6-7 ②） を優先的に使用し ます。

　 　 *****--------------------
• 傾向と し て [L6Mux Multi] < [Auto] < [L6Mux Single] < [PFU Mux] の順に回路規模が大き く な り ます。 た
だし、 ロジ ッ ク段数は [PFU Mux] < [L6Mux Single] < [Auto] < [L6Mux Multi] の順に増え る傾向があ り ま
す。 どの設定が最適かはデザイ ンに依存し ます。 Auto のま まにする こ と を推奨し ます。

*****--------------------

図 6-7. MUX Style オプシ ョ ンの影響を受ける SLICE 内のマルチプレ ク サ

Macro Search Path

パラ メ ータ : フ ォルダパス 　 　 デフ ォル ト 値 : ブラ ン ク

マ ク ロのラ イブラ リ パス設定です。 デザイ ンに IP コ ア （ネ ッ ト リ ス ト 提供） や EPIC で生成し たマ ク
ロ を使用し ている場合、 そのネ ッ ト リ ス ト フ ァ イル （*.ngo） またはラ イブラ リ フ ァ イル （*.nmc） の
あ る フ ォルダパス を記述し ます。IP やマ ク ロ を使用し ていない場合はブラ ン ク のま まで問題あ り ませ
ん。

①

②
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プロ ジ ェ ク ト フ ォルダ内にフ ァ イルが置かれている場合は、 ブ ラ ン ク のま まで構いません。 複数の
フ ォルダにフ ァ イルが有る場合は、 [ ； ] で区切って全てのパス を記述し て く ださい。 この際、 間にス
ペースは入れないで く ださい。 パスの記述は相対パスにも対応し ています。

Synplify Pro を使用し た場合、 [Translate Design] プロセスのオプシ ョ ンです。

Max Fanout Limit

パラ メ ータ : 最大フ ァ ンアウ ト 数 　 　 デフ ォル ト 値 : 1000

フ ァ ンア ウ ト 数の上限の制約設定です。 フ ァ ンア ウ ト がこの値を超えた場合は、 ド ラ イバを コ ピーし 
てフ ァ ンア ウ ト を減らす処理が行われます。 ただし、 この制約はあ く までガイ ド ラ イ ンであ り 、 制約
を満たすこ と によ り 最適化が妨げられる場合は無視されます。

Memory Initial Value File Search Path

パラ メ ータ : フ ォルダパス 　 　 デフ ォル ト 値 : ブラ ン ク

EBR （ブロ ッ ク メ モ リ ） の初期値設定を行 う 際に、 初期値を記述し たフ ァ イル （*.mem） が保存され
ている フ ォルダパス を指定し ます。 何も指定し ない場合は、 イ ンプ リ メ ンテーシ ョ ン ・ フ ォルダが参
照されます。

EBR の初期値設定を行わない場合は、 設定の必要はあ り ません。 また、 IPexpress で EBR を生成する
際に初期値フ ァ イルを指定し ている場合は、 こ こで再度指定する必要はあ り ません。

Number of Critical Paths

パラ メ ータ : パス数 デフ ォル ト 値 : 3

論理合成後のタ イ ミ ング検証結果と し て出力する ク リ テ ィ カルパス数の設定です。レポー ト は、[TOP
モジ ュール名 ]_lse.twr フ ァ イルに出力されます。

Optimization Goal

パラ メ ータ : Area ／ Balanced ／ Timing 　 　 デフ ォル ト 値 : Balanced

論理合成で優先するパラ メ ータ を決める設定です。 [Area] （デフ ォル ト ） では、 リ ソース数が最小に
な る よ う に論理合成が行われます。

[Balanced] を選択し た場合は、リ ソース数と タ イ ミ ングのバラ ン ス を考慮し た論理合成が行われます。

[Timing] を選択し た場合は、 動作周波数が最大と なる よ う に論理合成が行われます。

Output Preference File （Diamond 3.2 から削除）

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : False

論理合成の際に使用し た タ イ ミ ング制約を、 lpf （論理合成以降で使用する制約フ ァ イル） に出力させ
る設定です。 [False] （デフ ォル ト ） では、 lpf フ ァ イルは出力されません。

[True] を選択し た場合は、 lpf フ ァ イルに制約が出力されます。 なお、 このフ ァ イルは出力されるだ
けで、そのま ま以降の処理で参照されるわけではあ り ません。これを使用する場合は、Lattice Diamond 
にイ ンポー ト し てア ク テ ィ ブな制約と し て設定する必要があ り ます。

Propagate Constant

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : True

論理合成の際に、固定値または値が固定される回路の最適化に関する設定です。[True] （デフ ォル ト ）
では、 このよ う な回路は最適化され削除されます。

[False] を選択し た場合は、 回路が最適化されずに残 り ます。

RAM Style

パラ メ ータ : Auto ／ Block RAM ／ Distributed ／ Register 　 　 デフ ォル ト 値 : Auto

２ 次元配列等で RAM が推定される記述の実現方法 （ リ ソース） の設定です。 [Auto] （デフ ォル ト ） で
は LSE がサイ ズから適当な方法を選択し ます。

[Block RAM] を選択し た場合は、 EBR が使用されます。
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[Distributed] を選択し た場合は、 分散 RAM が使用されます。

[Registers] を選択し た場合は、 レジス タが使用されます。

なお、シフ ト レジス タが推定され RAM を使用し て構成された場合でも この設定の影響を う けません。

ROM Style

パラ メ ータ : Auto ／ EBR ／ Logic 　 　 デフ ォル ト 値 : Auto

２ 次元配列等で ROM が推定される記述の実現方法 （ リ ソース） の設定です。 [Auto] （デフ ォル ト ）
では LSE がサイ ズから適当な方法を選択し ます。

[EBR] を選択し た場合は、 EBR が使用されます。

[Logic] を選択し た場合は、 フ ァ ブ リ ッ ク内のロ ジ ッ ク リ ソースで固定値の配列が構成されます。

Remove Duplicate Registers

パラ メ ータ : True ／ False デフ ォル ト 値 : True

同じ機能 （論理） を実現する レジス タが複数あった場合の、 最適化 （削除） に関する設定です。 [True]
（デフ ォル ト ） では、 このよ う なレジス タは リ ソース数削減のために削除されます。 [False] を選択し
た場合は、 削除されずに残 り ます。

Remove LOC Properties

パラ メ ータ : On ／ Off デフ ォル ト 値 : Off

HDL ソース内に記述されたピンアサイ ン情報に関する設定です。 [Off] （デフ ォル ト ） では HDL ソー
ス内のピンアサイ ン情報は以降のプロセスに引き継がれます。 ただし、 HDL ソース と 制約フ ァ イル
（*.lpf） の設定が異な る場合、 以降のプロセスでは制約フ ァ イルの設定が優先されます。

[On] を選択し た場合、 HDL ソース内のピンアサイ ン情報は以降のプロセスに引き継がれません。

Resolve Mixed Drivers （Diamond 3.2 から追加）

パラ メ ータ : True ／ False デフ ォル ト 値 : False

[True] を選択する と、 ア ク テ ィ ブな信号および VCC （または GND） が同時に ド ラ イブし ている場合、
VCC （または GND） で固定し ます。

Resource Sharing

パラ メ ータ : True ／ False デフ ォル ト 値 : True

リ ソースシェア リ ング （ リ ソース共用の最適化処理） に関する設定です。

[True] （デフ ォル ト ） を選択し た場合、 使用する リ ソース を減らすために、 複数あ る同一機能の回路
を共有させる処理が行われます （図 6-8）。 [False] を選択し た場合、 この処理は行われません。

図 6-8. Resource Sharing 処理の一例

Target Frequency

パラ メ ータ : 数値 （周波数） 　 　 デフ ォル ト 値 : 200

目標動作周波数の設定です。 この設定は [Optimization Goal] オプシ ョ ンが [Area] 設定以外の場合に有 
効にな り ます。 また、 この設定はデザイ ン内の全ての ク ロ ッ クが対象と な り ます。 ク ロ ッ ク個別に制
約を設定する場合は、 sdc フ ァ イルに制約を記述し て く ださい。
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ただし、 [Optimization Goal] オプシ ョ ンが [Area] に指定されている場合、 本値は無視され、 1 MHz を  
適用し ます。

Use Carry Chain

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : True

演算回路実装の際の Carry Chain の使用可否の設定です。 [True] （デフ ォル ト ） では演算回路の実装 
に Carry Chain を使用する こ と が許可されます （使用するかど う かは回路構成と [Carry Chain Length]   
オプシ ョ ンの設定に依存し ます）。

[False] を選択し た場合は、 演算回路の実装に Carry Chain が使用されません。

Use IO insertion

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : True

論理合成の際の IO バッ フ ァ挿入に関する設定です。 [True] （デフ ォル ト ） では論理合成時に最上位
階層のポー ト に IO バッ フ ァが挿入されます。

[False] を選択し た場合は、 IO バッ フ ァは挿入されません。

Use IO Registers

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : True

論理合成時の IO レジス タ使用の可否設定です。 [True] （デフ ォル ト ） では IO レジス タ を使用する こ
と が許可されます （使用するかど う かは回路構成に依存し ます）。

[False] を選択し た場合は IO レジス タは使用されません。

Use LPF Created from SDC in Project （Diamond 3.2 から追加）

パラ メ ータ : True ／ False デフ ォル ト 値 : True

[True] （デフ ォル ト ） では制約フ ァ イル .ldc に基づいた .lpf フ ァ イルを生成し ます。

VHDL 2008 （Diamond 3.2 から追加）

パラ メ ータ : True ／ False デフ ォル ト 値 : False

VHDL バージ ョ ン指定のためのオプシ ョ ンです。 [True] （デフ ォル ト ） ではプロ ジェ ク ト の VHDL 言
語仕様と し て IEEE 1076-2008 を選択し ます。

6.2.3 LSE 論理合成制約の設定

6.2.3.1 制約フ ァ イルの管理

　 本節では論理合成用制約フ ァ イルの管理方法について説明し ます。

　 Lattice Diamond では、 論理合成用の制約フ ァ イル (Synthesis Preference File) を イ ンポー ト する こ と で論理   
合成ツールにタ イ ミ ング制約や論理合成方法の指示を与え る こ と ができ ます。 ス ト ラ テジ設定はデザイ ン全
体 （グ ローバル） に適用されるオプシ ョ ン一式であ るのに対し て、 論理合成制約フ ァ イルを用いる こ と で、
例えばク ロ ッ ク ネ ッ ト 毎に周波数制約を与え る、 など と いった よ り 詳細な コ ン ト ロールが可能にな り ます。
制約フ ァ イルがな く て も論理合成処理自体は支障あ り ませんが、 生成される EDIF の質は異な り ます。 

6.2.2.2 既存の制約フ ァ イルのイ ンポー ト

　 プロジェ ク ト 作成時には、 論理合成制約フ ァ イルは何も イ ンポー ト されていません。 既存の制約フ ァ イル
を イ ンポー ト する場合は、 メ ニューバーから [File] => [Add] => [Existing File…] と選択するか、 File List ウ イ      
ン ド ウ内 『Synthesis Constraint Files』 行を右ク リ ッ ク し （図 6-9） [Add] => [Existing File…] を選択し ます。
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図 6-9. 既存の論理合成制約のイ ンポー ト

　 これで、 イ ンポー ト する フ ァ イルの選択ウ イ ン ド ウ （図 6-10） が立ち上が り （File of Type は [Synthesis   
Constraint Files]）、 フ ォルダ内にあ る制約フ ァ イル候補が表示されるので、ブラ ウ ズ し て適当なフ ァ イルを選 
択後、 [Add] ボタ ンを ク リ ッ ク し ます。

　 この際、 ウ イ ン ド ウ左下の [Copy file to ….] にチェ ッ クが入っている と、 イ ンプ リ メ ンテーシ ョ ン ・ フ ォ   
ルダにコ ピーが作成され、 それがイ ンポー ト されます。 チェ ッ クが入っていない場合は、 選択し たフ ァ イル
が リ ン ク されて イ ンポー ト されます。

図 6-10. イ ンポー ト する制約フ ァ イルの選択

6.2.3.3 適用する制約フ ァ イルの選択

　 イ ンプ リ メ ンテーシ ョ ンでは、 プロジェ ク ト に複数の論理合成制約を イ ンポー ト する こ と ができ、 デフ ォ
ル ト ではイ ンポー ト し た全ての論理合成制約が適用されます。 イ ンポー ト されている論理合成制約を適用し
ないよ う にするには、 論理合成制約の非ア ク テ ィ ブ化を行います。 File List ウ イ ン ド ウでア ク テ ィ ブな論理 
合成制約を右ク リ ッ ク し、 [Set as Inactive] を選択し ます （図 6-11）。 これでイ ンプ リ メ ンテーシ ョ ンには適   
用されな く な り ます。非ア ク テ ィ ブにし た論理合成制約をア ク テ ィ ブ化するには、同様の手順で [Set as Active  
LDC] （または SDC） を選択し ます。 

　 ア ク テ ィ ブな論理合成制約は太字で、 非ア ク テ ィ ブな論理合成制約は細字で表示されます。

右クリック
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図 6-11. 論理合成制約の非ア ク テ ィ ブ化

6.2.3.4 論理合成制約の削除

　 不要になった論理合成制約は、 プロ ジェ ク ト から削除する こ と も でき ます。 図 6-11 と 同様に右ク リ ッ ク 
し [remove] を選択するか、 選択し た状態でキーボード の [Delete] キーを押すこ と でプロ ジェ ク ト から削除さ
れます。 「プロ ジェ ク ト から削除」 と は 「イ ンポー ト 情報の削除」 で、 フ ァ イル自体の削除ではあ り ません。

6.2.3.5 LSE 用新規制約フ ァ イルの作成

　 論理合成制約フ ァ イルを新たに作成し て追加ます。 メ ニューバーから [File] => [New] => [File…] の順に選    
択するか、 File List ウ イ ン ド ウ内で 『Synthesis Constraint Files』 行を右ク リ ッ ク し、 [Add]=> [New File...] を     
選択し ます。 New File Wizard 図 6-13 が起動し ます。

図 6-12. 新規論理合成制約の追加

右クリック

右クリック



JUG_D3.3synthesis_v1.1 6-12

Lattice Diamond 日本語ユーザガイ ド

図 6-13. New File Wizard （新規 LDC フ ァ イルの追加）

　 Categories 欄で [Source Files]、 Source Files 欄で [LDC Files] または [SDC File] を選択し、 Name 欄にフ ァ イ    
ル名を入力し ます。 適切なフ ォルダを指定後に New ボタ ンを ク リ ッ クする と、 新しい論理合成制約フ ァ イル
が作成されます。

　 SDCの場合はテキス ト エデ ィ タが、LDCの場合はLDC Editor（LDC設定用のGUI ツール）が立ち上が り ます。

6.2.4 Netlist Analyzer

　 LSE を論理合成ツール と し て選択 し た場合の回路図情報を グ ラ フ ィ カルに閲覧す る ツールが Netlist
Analyzer です。 起動するにはア イ コ ンを ク リ ッ クする （図 6-14、 左） か、 Tools メ ニ ューから選択する （図 6-  
14、 右） こ と によ って行います。

図 6-14. Netlist Analyzer の起動

　 起動後の初期画面は図 6-15 のよ う にな り （一部） ます。枠右上すみの ア イ コ ンを ク リ ッ ク し て Nnetlist

Analyzer 表示枠全体をデタ ッチ （独立に） する こ と を推奨し ます。 実装回路規模が小さい場合を除き、 閲覧
するには細かすぎ るためです。 RTL View のスケマテ ィ ッ クがデフ ォル ト で表示されます。

アイコン
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図 6-15. Netlist Analyzer 起動後のア イ コ ン表示

　 ア イ コ ン列はウ ィ ン ド ウの左側に並んでいます。 上部には RTL View / Netlist View （および Diamond 3.4 か     
ら Post-MAP View) 各表示を起動する ア イ コ ンがあ り ます。

　 その下にはモジ ュール階層の上下移動のために矢印のア イ コ ンがあ り ます。 スケマテ ィ ッ ク表示内で （サ
ブ） モジ ュールの箱の上にア イ コ ンを移動する と、 下位階層があ る場合はア イ コ ンが下向き青矢印表示にな
り 、 ク リ ッ クする こ と で下位層のスケマテ ィ ッ ク表示にな り ます。 上位階層への移動は何も回路素子がない
一にア イ コ ンを移動する事で、 上向き緑矢印が表示されますので ク リ ッ ク し ます。

　 ア イ コ ン列下部にはページやシー ト の移動用の左右向き矢印ア イ コ ンがあ り ます。

　 （Diamond 3.4 からはさ らにその下に表示ウ ィ ン ド ウの様式を変え る ア イ コ ンが追加されます。）

　 ア イ コ ン列の右枠は リ ソース表示ウ ィ ン ド ウです。 イ ン ス タ ン ス、 ポー ト 、 ネ ッ ト の三つに分類されてい
ます。

図 6-16. Netlist Analyzer によ る リ ソース リ ス ト 確認

　 図 6-16 のよ う に リ ソース （名） 行頭の三角マーク を ク リ ッ ク し てエ ク スパン ド （その下位や内容を表示）

RTL View
Technology View

Post-MAP View（3.4から）

モジュール上下階層移動

シート移動

ページ移動

（Diamond 3.4から対応）

拡大・縮小・フィット

をクリックして expand
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し ます。 アルフ ァベッ ト 順にいすと されています。 特のモジュールはポー ト 、 ネ ッ ト を ク リ ッ ク し て選択す
れば、 図 6-17 のよ う にスケマテ ィ ッ ク部の該当 リ ソースが赤表示でハイ ラ イ ト されます。

図 6-17. Netlist Analyzer によ るハイ ラ イ ト

　 オブジ ェ ク ト のサーチ

　 　 特定の リ ソースやネ ッ ト を探すと きの機能 『find』 があ り ます。 Netlist Analyzer を起動後、 スケマテ ィ ッ 
ク窓内で回路記号がブラ ン クの領域にマウ ス を移動し て、 右ク リ ッ ク し、 『Find...』 を選択し ます。

図 6-18. Find ダ イ ア ロ グの起動

図 6-19. Find Dialog ウ ィ ン ドー

右クリック
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　 表示される図 6-19 のダ イ ア ロ グで、 上部タブの 『instances』、 『Symbols』、 『Nets』。 『Ports』 から意図する 
対象 リ ソース を選択し ます。 次いでその下 Search セ ク シ ョ ンでサーチする階層を指定し ます。 デフ ォル ト は
『Current Level Only』 です。 Current Level は本ダ イ ア ロ グを立ち上げた際にマウ ス ク リ ッ ク し た解像です。

　 その後、 左側に表示 さ れ る対象候補を選択し て矢印 『->』 な ど を操作し て 『Highlight』 部に移動 さ せて
”Close” を ク リ ッ ク し ます。 各矢印で選択指定と解除を適切に行います。

図 6-20. ク ロ ッ ク ネ ッ ト ワーク を Find 指定し た後の表示例

　 マク ロのパラ メ ータ確認

　 　 Netlist Analyzer では、 デザイ ン内で私用されている特定マ ク ロのパラ メ ータ設定を確認する こ と ができ 
ます。 『Technology View』 を選択し て回路図を表示後、 意図する マ ク ロの上にマウ ス を移動させます。 その 
マ ク ロで定義されているパラ メ ータに対し て、 どのよ う に設定されているかが表示されます。

図 6-21. マ ク ロ （CLKDIV） の表示例

6.2.5 LDC エデ ィ タ を使用し た LSE の制約設定

　 本節では LDC エデ ィ タの使い方等について記述し ます。

【重要】 Diamond 3.3 時点では、 （可能な限り言及し ていますが） 以降に記述する制約設定が有効に作用し な 
いケースや制約項目があ り ます。 意図する通り に動作し ているかチ ェ ッ クする こ と を推奨し ます。

マウスをイン
スタンス上に
ドラッグして
右クリック
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　 LSE の場合、論理合成制約フ ァ イルの拡張子は [.ldc] と な り ます。新しい LDC フ ァ イルを作成する と、LDC
エデ ィ タが起動し ます。

図 6-22. LDC エデ ィ タの初期ウ ィ ン ド ウ

　 LDC エデ ィ タでは、 以下の制約設定を行 う こ と ができ ます。

• Clocks タブ ： ク ロ ッ クの周期指定

• Inputs/Outputs タブ ： 入力ポー ト の最大入力遅延、 出力ポー ト の最大遅延

• Delay Paths タブ ： 特定パスのフ ォルスパス / マルチサイ クルパス / 最大遅延

• Clock Group タブ ： 任意の ク ロ ッ ク相互関係が非同期、 或いは非依存であ る こ と を明示

• Generated Clocks タブ ： ユーザロ ジ ッ ク で生成された ク ロ ッ ク を指定

• Attribute タブ ： LSE のサポー ト する Synplify Lattice Attribute を指定

6.2.4.1 ク ロ ッ ク周期指定 （Clocks タ ブ）

ク ロ ッ ク周期指定は Clocks タブで行います。 Source 欄を ク リ ッ クする と、 デザイ ン内のク ロ ッ ク の
リ ス ト が表示されます。 この中から制約を与え る ク ロ ッ ク を選択し ます。 Clock Name 欄には、 任意 
の ク ロ ッ ク名（LSE 内でのみ使用するエイ リ アス名）を、Period（ns）欄ではク ロ ッ ク周期を入力し ます。

図 6-23. LDC Editor によ る ク ロ ッ ク周期指定

6.2.4.2 入力ポー ト の最大遅延指定 （Inputs/Outputs タ ブ）

入力ポー ト の タ イ ミ ン グ制約 と し て最大遅延 （ク ロ ッ ク エ ッ ジか ら入力データ確定までの遅延値、
図 6-24） を与え る こ と ができ ます。
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図 6-24. 入力 （最大） 遅延

図 6-25. LDC Editor によ るポー ト タ イプ （入力） 選択

Type 欄で Input を選択し ます （図 6-25）。

Port 欄を ク リ ッ クする と入力ポー ト の リ ス ト が、 Clock 欄を ク リ ッ クする と ク ロ ッ ク ポー ト の リ ス ト
が表示されますので （図 6-26）、それぞれ制約の対象を選択し、Value 欄に制約値を入力し ます （図 6-  
28）。

図 6-26. LDC Editor によ る入力ポー ト 選択

6.2.4.3 出力ポー ト の最大遅延指定 （Inputs/Outputs タ ブ）

出力ポー ト への タ イ ミ ン グ制約 と し て最大遅延 （ク ロ ッ ク エ ッ ジか ら出力データ確定までの遅延、
図 6-27） を与え る こ と ができ ます。

図 6-27. 出力 （最大） 遅延
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Type 欄で Output を選択し ます （図 6-28）。

Port 欄を ク リ ッ クする と出力ポー ト の リ ス ト が、 Clock 欄を ク リ ッ クする と ク ロ ッ ク ポー ト の リ ス ト
が表示されるので、 それぞれ制約の対象とする ものを選択し、 Value 欄に制約値を入力し ます。

図 6-28. LDC Editor によ る出力最大遅延指定

6.2.4.4 マルチサイ クルパス指定 （Delay Paths タ ブ）

特定パスへのタ イ ミ ング制約 と し てマルチサイ クルパス指定 （複数ク ロ ッ ク サイ クルでのデータ転
送） を与え る こ と ができ ます。

マルチサイ クルパス指定には、 まず Delay Type 欄で Multicycle を選択し ます （図 6-29）。

図 6-29. LDC Editor によ る Delay Paths 内のタ イプ選択

From 欄および To 欄を ク リ ッ クする と制約の対象と なる レジス タやネ ッ ト 名の リ ス ト が表示される
のでパスの始点 （From） と終点 （To） を選択し ます （図 6-30）。

図 6-30. LDC Editor によ るマルチサイ クル指定 （From）
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From ／ To どち らかは省略する こ と ができ ます。 また、 指定し たパスに複数の経路があ る場合は、
Through 欄でネ ッ ト 名を選択する こ と で経路を限定する こ と もでき ます。Cycle 欄には制約値 （ク ロ ッ
ク数） を入力し ます （図 6-31）。 Max delay 欄の入力は不要です。

図 6-31. LDC Editor によ るマルチサイ クル指定後

6.2.4.5 フ ォルスパス指定 （Delay Paths タ ブ）

特定パス を タ イ ミ ング解析の対象から除外する、 フ ォルスパス指定を与え る こ と ができ ます （図 6- 
32）。

まず Delay Type 欄で False を選択し ます。From 欄および To 欄を ク リ ッ クする と制約の対象と なる レ 
ジス タやネ ッ ト 名の リ ス ト が表示されるのでパスの始点 （From） と 終点 （To） を選択し ます。 From
／ To どち らかは省略する こ と ができ ます。 また、 指定し たパスに複数の経路があ る場合は、 Through
欄でネ ッ ト 名を選択する こ と で経路を限定する こ と もでき ます。 Cycle 欄および Max delay 欄の入力 
は不要です。

6.2.4.6 最大パス遅延 （Delay Paths タ ブ）

特定パスに対する最大遅延指定は Delay Paths タブで行います。

Delay Type 欄で Max Delay を選択し ます。From 欄および To 欄を ク リ ッ クする と制約の対象と なる レ  
ジス タやネ ッ ト 名の リ ス ト が表示されるのでパスの始点 （From） と 終点 （To） を選択し ます。 From
／ To どち らかは省略する こ と ができ ます。 また、 指定し たパスに複数の経路があ る場合は、 Through
欄でネ ッ ト 名を選択する こ と で経路を限定する こ と もでき ます。 Maxdelay 欄には制約値 （単位は ns）
を入力し ます （図 6-32）。 Cycle 欄の入力は不要です。

図 6-32. LDC Editor によ る最大パス遅延の指定

6.2.4.7 ク ロ ッ ク相互関係 （Clock Group タ ブ）

特定の 2 ク ロ ッ ク が非同期関係、或いは非依存の関係にあ る場合に明示的に指定する こ と で、 タ イ ミ
ング解析が不要な こ と をツールに指示し ます。

まず Type 欄で関係が非同期 （asynchronous） か非依存 （exclusive） かを選択し ます。
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図 6-33. LDC エデ ィ タによ る 2 ク ロ ッ ク間の関係の選択

次に二つあ る Group 欄にそれぞれ意図する ク ロ ッ ク （ブループ） を ク リ ッ クする と表示される候補
からプルダウ ン形式で選択し ます。

図 6-34. LDC エデ ィ タによ る非同期関係にあ る ク ロ ッ クの指定

6.2.4.8 ユーザ論理で生成する ク ロ ッ クの指定 （Generated Clocks タ ブ）

ユーザ論理回路で生成する分周ク ロ ッ ク などの指定を行います。

まず Source 欄を ク リ ッ クする と表示される ク ロ ッ クの候補から意図する信号を生成するための大元
にな る ピン名を選択し ます。 Name 欄はエイ リ アス名であ り 、 入力は任意です。

Master Clock 欄は生成ク ロ ッ ク の元になっている信号です。

次いで Divide Factor と Multiply Factor を入力し ます。 必ずどち らか一方には入力し なければな り ま  
せん。 値は整数です。

Object 欄で意図するユーザ生成ク ロ ッ ク を選択し ます。

図 6-35. LDC エデ ィ タによ るユーザ生成ク ロ ッ クの指定
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6.2.4.9 Synplify Lattice Attribute の指定 （Attribute タ ブ）

図 6-36. LDC エデ ィ タで選択でき る ア ト リ ビ ュー ト （からの選択）

LSE でサポー ト する Synplify Attribute を指定し ます。まず Attribute 欄で ク リ ッ クする と表示される候 
補から意図する ア ト リ ビ ュー ト を選択し ます （図 6-36）。

次いで Object Type 欄でプルダウ ンから対象オブジェ ク ト のタ イプを指定し ます （図 6-37）。

次に Object 欄で選択し たア ト リ ビ ュー ト を適用するオブジェ ク ト を、 同様にク リ ッ ク し て表示され
る候補か ら選択し ます （Netlist Analyzer GUI から ド ラ ッ グ＆ ド ロ ッ プ形式で指定する こ と も可能で  
す）。 候補に表示されないア ト リ ビ ュー ト は未サポー ト です。

Value Type 欄と Value 欄は、 選択されたア ト リ ビ ュー ト に準じ て選択可能な候補が表れますので、 そ  
れぞれ選択し ます。 Description 欄にはア ト リ ビ ュー ト についての説明が表示されます。

図 6-37. ア ト リ ビ ュー ト 適用オブジェ ク ト のタ イプ選択

6.2.5 ア ト リ ビ ュー ト の RTL 記述例

　 LSE でサポー ト する ア ト リ ビ ュー ト 一覧 6.6 節に示し ますが、 参考 と し て、 い く つかの例を示し ます
（Synplify-Pro も同様）。

VHDL 例

（定義し た信号 ・ ノード を論理圧縮で削除し ないで残す）

attribute syn_keep : boolean; -- ワ イヤ （ノード） の保持

attribute syn_keep of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名
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attribute syn_preserve : boolean; -- FF の保持

attribute syn_preserve of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名

attribute syn_noprune : boolean; -- 出力がない リ ソース削除の禁止

attribute syn_noprune of <signal_name>: signal is true; -- “signal_name” は signal 定義し た信号名

（FSM のコーデ ィ ング方式）

attribute syn_encoding : boolean; -- [sequential, binary, onehot], 他に safe （”default” 記述有効化）

attribute syn_encoding of <fsm_nodes>: signal is “safe, Boolean”; --“fsm_nodes” は signal 定義し た FSM 名

Verilog HDL 例

（I/O タ イプ指定、 ポー ト 宣言行）

input CLKIN /* synthesis IO_TYPE="LVCMOS18" */ ;

output CLKOUT /* synthesis IO_TYPE="LVDS25E" */ ; 

（定義し た信号 ・ ノード を論理圧縮で削除し ないで残す。 ノード定義行）

reg [x:0] <FF_name> /* synthesis syn_preserve=1 */;

wire [y:0] <wire_name> /* synthesis syn_keep=1 */;

（FSM のコーデ ィ ング方式。 FSM ノード定義行）

reg [z:0] <FF_FSM_name> /* synthesis syn_encoding=”safe, binary” */;

6.3 Synplify Pro

6.3.1 ス ト ラ テジ設定

　 特に Synplify Pro に関し ては、 Diamond のバージ ョ ンによ ってス ト ラテジ設定オプシ ョ ンの削除や新規追 
加、 またはデフ ォル ト 指定の変更が行われていますので、 留意し て く だ さい。 旧バージ ョ ンから ア ッ プデー
ト する場合は、 必ず確認し て く ださい。

6.3.2  ス ト ラ テジ設定ウ イ ン ド ウの起動

　 起動方法は LSE と同じです （図 6-5 参照）。

6.3.3 Synplify Pro ス ト ラ テジ ・ オプシ ョ ン

　 以下にス ト ラ テジ ・ オプシ ョ ン各設定の詳細を説明し ます。

Allow Duplicate Modules

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : False

Verilog HDL で同じ名前のモジュールが複数定義されている場合の処理に関する設定です。

[False] （Default） を選択し た場合、 1 つのデザイ ン内に同じ名前のモジュールが複数定義されている
と、 エラーにな り 論理合成が行われません。 [True] を選択し た場合、 1 つのデザイ ン内に同じ名前の
モジ ュールが複数定義されている と、最後に定義されたモジ ュールだけが使用され、他のモジュール
は無視されます。

Area

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 :  MachXO フ ァ ミ リ のみ True、 それ以外は False

Area （ リ ソース数） を小さ く する ためのオプシ ョ ン設定です。
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[True] を選択する と Area を最小にする ために周波数制約を 1MHz に設定し て論理合成を行います。こ
の場合、 [Frequency] オプシ ョ ンの設定値は無視されます。 sdc フ ァ イルに ク ロ ッ クの周波数 （周期）
設定がされている場合は、 sdc フ ァ イル内の設定が優先されます。

Arrange VHDL Files

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : True

VHDL フ ァ イルを コ ンパイルする際に、自動的に最上位モジュールが最後にコ ンパイルされる よ う に
コ ンパイル順を変更するためのオプシ ョ ンです。

[True] の場合は、 自動的にコ ンパイル順が調整されます。 [False] の場合は、 File List ウ イ ン ド ウで表 
示されている順に上から コ ンパイルされます。

Clock Conversion （Diamond 2.1 以降）

パラ メ ータ : True ／ False デフ ォル ト 値 : True

ゲーテ ッ ド ・ ク ロ ッ クやユーザロ ジ ッ ク生成の ク ロ ッ ク ためのオプシ ョ ンです。 従来での Fix Gated 
Clocks や Fix Generated Clocks オプシ ョ ン と同等の機能です。

[True] の場合は、 CE ベースの回路に変換し ます。 [False] では変換し ません。

Command Line Options

パラ メ ータ : 文字列 デフ ォル ト 値 : ブラ ン ク

この ド キ ュ メ ン ト で紹介し ている GUI の リ ス ト に表示されていない特別なオプシ ョ ンを使用する場
合に、 直接引数等を記述し ます。 設定する場合は、 以下のよ う に記述し ます。

set_option オプシ ョ ン

記述でき るオプシ ョ ンは １ つだけです。 オプシ ョ ンの詳細は Synplify Pro の Reference Manual や User  
Guide をご覧 く ださい。

Default Enum Encoding

パラ メ ータ : Default ／ Onehot ／ Gray ／ Sequential 　 　 デフ ォル ト 値 　 Default

VHDL の列挙 （enum） 型変数が定義されている場合、 その変換形式に関する設定です。

[Default] を選択し た場合、 型の メ ンバ数に応じ て自動的に割 り 振られます。

[Onehot] を選択し た場合、 各 メ ンバに [onehot] （全 bit 中 1bit のみが '1'） の値が割 り 当て られます
（例 :0001, 0010, 0100, 1000）。

[Gray] を選択し た場合、 各 メ ンバに一度の変化で 1bit のみが変化する よ う な値が割 り 当て られます
（例 :000, 001, 011, 111, 110, 010）。

[Sequential] を選択し た場合、 一度に複数 bit が変化する よ う な値 （基本的には binary counter） が割 り  
当て られます。

Disable IO Insertion

パラ メ ータ : True ／ False デフ ォル ト 値 : False

ネ ッ ト リ ス ト への I/O バッ フ ァ挿入に関する設定です。

[False] （デフ ォル ト ） を選択し た場合、 最上階層のソースのポー ト に I/O バッ フ ァ が挿入されます。

[True] を選択し た場合は I/O バッ フ ァ が挿入されません。 

I/Oバッ フ ァ の無いネ ッ ト リ ス ト は配置配線ができ ません。IPコ アの生成等の特殊な場合を除き[True]
を選択し ないで下さい。

Export Diamond Settings to Synplify Pro GUI （Diamond 2.1 以降）

パラ メ ータ : No ／ Only on First Launch ／ Yes デフ ォル ト 値 : No

Synplify Pro を Tools メ ニューから立ち上げて論理合成処理を行 う 場合に、ス ト ラ テジ設定各オプシ ョ  
ンをエ ク スポー ト するかど う かを指定するためのオプシ ョ ンです。
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デフ ォル ト の [No] は Diamond 2.0 までの動作と同じです。 [Yes] の場合は、 Synplify Pro が呼ばれる ご  
と にス ト ラ テジ設定を取 り 込んで起動し、それ以前のセ ッ シ ョ ンで保存された設定があって も無効に
な り ます。

[Only on First Launch] では、 最初の起動時のみにス ト ラ テジ設定を取 り 込んで起動し、 それ以後は直   
前のセ ッ シ ョ ンでの設定やデフ ォル ト を用いて起動し ます。

FSM Encoding

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : True

ステー ト マシン用のコ ンパイ ラであ る FSM （Finite State Machine） コ ンパイ ラの使用に関する設定で  
す。

[True] （デフ ォル ト ） を選択し た場合は FSM コ ンパイ ラが使用されますが、 [False] を選択し た場合、
FSM コ ンパイ ラは使用されないため、 ステー ト マシンに対し て最適な論理合成が行われない可能性
があ り ます。

Fanout Guide （Diamond 2.1 以前の名称 ： Fanout Limit）

パラ メ ータ : 最大フ ァ ンアウ ト 数 　 　 デフ ォル ト 値 : 1000 （旧値は 100）

フ ァ ンア ウ ト 数の上限の制約設定です。 フ ァ ンア ウ ト がこの値を超えた場合は、 ド ラ イバを コ ピーし 
てフ ァ ンア ウ ト を減らす処理が行われます。 ただし、 この制約はあ く までガイ ド ラ イ ンであ り 、 制約
を満たすこ と によ り 最適化が妨げられる場合は無視されます。

なお、 Synplify Pro では特定のネ ッ ト ワークに対する フ ァ ンア ウ ト を制限するために RTL に以下の記 
述を し て も有効です。 ”value” が意図する上限値です。

Verilog [wire | reg] <object 名宣言 > /* synthesis syn_maxfan = "value" */ ;

VHDL attribute syn_maxfan of object : objectType is "value" ;

Fix Gated Clocks （Diamond 2.1 以降はあ り ません）

パラ メ ータ : 0 ／ 1 ／ 2 ／ 3 デフ ォル ト 値 : 3

[Gated Clock Conversion] 処理と そのレポー ト 出力に関する設定です。

[Gated Clock Conversion] は、 ソース内では Clock の Gating に使用し ている信号を レジス タの CE （ク  
ロ ッ ク イ ネーブル） ポー ト に接続し、 回路の同期化を行 う 処理です （図 6-38）。

[0] を選択し た場合は、 [Gated Clock Conversion] 処理が行われません。

[1] を選択し た場合は、 [Gated Clock Conversion] 処理が行われますが、 レポー ト されません。

[2] を選択し た場合は、 [Gated Clock Conversion] 処理が行われ、 変換でき なかった ク ロ ッ ク ネ ッ  
ト に関し てのみレポー ト されます。

[3] を選択し た場合は、 [Gated Clock Conversion] 処理が行われ、 全ての Gated Clock に関する処理   
結果がレポー ト されます。

図 6-38. Fixed Gated Clock オプシ ョ ンでの ク ロ ッ ク最適化の一例



6-25 JUG_D3.3synthesis_v1.1

論理合成

なお、 [0] 以外を選択し た場合で も、 以下の条件を満た さ ない リ ソースに対し てはこの [Gated Clock 
Conversion] が行われません。

1. sdc フ ァ イル内で、 define_clock 指示子によ り Gating 前のク ロ ッ ク が定義されている場合

2. ゲーテ ッ ド ・ ク ロ ッ ク の接続先が、 Sequential primitive （基本的にはレジス タのみ） の場合

3. Gating する論理が AND や OR 等の場合 （XOR 等は変換されない）

ブロ ッ ク RAMやDSP ブロ ッ クは、論理合成ではブラ ッ ク ボ ッ ク ス と し て扱われる（Sequential Primitive 
ではない） ため、 これらに接続されるゲーテ ッ ド ・ ク ロ ッ クに対し ては、 Conversion 処理は行われま
せん。 また、 Gating の論理によ っては Conversion が行われない場合も あ り ます。

Fix Generated Clocks （Diamond 2.1 以降はあ り ません）

パラ メ ータ : 0 ／ 1 ／ 2 ／ 3 デフ ォル ト 値 : 3

デバイ ス内のレジス タ出力等か ら生成された ローカルク ロ ッ ク の最適化処理 と そのレポー ト 出力に
関する設定です。

こ の処理では、 デバイ ス内で生成された分周ク ロ ッ ク等のローカルク ロ ッ ク を、 元の ク ロ ッ ク と ク
ロ ッ ク イ ネーブルに変換し、 回路の同期化を行います （図 6-39）。

図 6-39. Fixed Generated Clocks オプシ ョ ンでの ク ロ ッ ク最適化の一例

[0] を選択し た場合は、 この処理は行われません。

[1] を選択し た場合は、 この処理は行われますが結果等についてはレポー ト されません。

[2] を選択し た場合は、 この処理が行われ変換が行われなかった ローカルク ロ ッ ク に関し てのみ
レポー ト されます。

[3] を選択し た場合は、 この処理が行われ全てのローカルク ロ ッ ク に関する処理結果がレポー ト
されます。

なお、 [0] 以外を選択し た場合で も、 回路構成によ ってはこの処理が行われない場合も あ り ます。

-- 例

分周ク ロ ッ クが階層を またいで他のモジュールで使用されている。

分周ク ロ ッ クが最上位階層の出力ポー ト に接続されている。

Force GSR

パラ メ ータ : Auto ／ False ／ True デフ ォル ト 値 : False

論理合成時の GSR （Global Set/Reset） 挿入に関する設定です。

[Auto] ／ [True] を選択し た場合は自動的に GSR バッ フ ァ が挿入されます （ただし、 Set/Reset の構成
が条件を満た し た場合のみ）。

[False] を選択し た場合は GSR が使用されません。

GSR はマ ッ ピング （Ｍap Design） プロセスで、 よ り 最適な条件で挿入する こ と ができ ます。 特別な 
理由のない限 り このオプシ ョ ンは [False] を選択する こ と を推奨し ます。
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Frequency （MHz）

パラ メ ータ : 周波数 [MHz] デフ ォル ト 値 : な し （Diamond 2.2 以前は 200）

ク ロ ッ クの周波数の制約設定です。

Area 設定が [False] の場合のみ、 このオプシ ョ ンで設定し た値を周波数制約とする論理合成ス ク リ プ
ト を生成し ます。 この周波数制約は全てのパス （レジス タ - レジス タ間） に対し て適用されます。

Number of Critical Paths

パラ メ ータ : パス数 デフ ォル ト 値 : な し （Diamond 2.2 以前は 3）

論理合成のレポー ト 内に出力する ク リ テ ィ カルパス数の設定です。

ク リ テ ィ カルパスは [Number of Start/End point] オプシ ョ ン （デフ ォル ト 値 0） が 1 以上の場合のみレ    
ポー ト されますので、 ク リ テ ィ カルパス を レポー ト させる場合は "Number of Start/End point" を 1 以   
上に設定し て く ださい。

Number of Start/End points

パラ メ ータ : 数値 デフ ォル ト 値 : な し （Diamond 2.2 以前は 0）

論理合成後のタ イ ミ ング見積も り 結果と し てレポー ト するパス数の設定です。

このオプシ ョ ン設定が 1 以上の場合のみ [Critical Path] の詳細がレポー ト されます。

Output Netlist Format

パラ メ ータ : None ／ VHDL ／ Verilog デフ ォル ト 値 : None

論理合成後の HDL ネ ッ ト リ ス ト 出力の設定です。

[None] （デフ ォル ト ） を選択し た場合、 論理合成後のネ ッ ト リ ス ト は EDIF のみが出力され HDL の
ネ ッ ト リ ス ト は出力されません。

[VHDL] を選択し た場合は、 EFID と VHDL のネ ッ ト リ ス ト （*.vhm） が出力されます。 [Verilog] を選
択し た場合は、 EFID と Verilog HDL のネ ッ ト リ ス ト （*.vm） が出力されます。

Output Preference File

パラ メ ータ True ／ False デフ ォル ト 値 : True （Diamond 2.1 までは False）

Lattice Diamond の制約フ ァ イル出力に関する設定です。

デフ ォル ト の [True] では、 論理合成時の制約から必要な制約だけを記述し た Lattice Diamond の制約 
フ ァ イルを出力し ます。出力フ ァ イル名は " プロ ジェ ク ト 名 _ イ ンプ リ メ ンテーシ ョ ン名 _synplify.lpf" 
です。 必要に応じ て Lattice Diamond にイ ンポー ト するか、 必要な部分のみを使用する制約フ ァ イル 
にコ ピーするかし て使用し て く ださい。

[False] を選択し た場合、 このフ ァ イルは出力されません。

Pipelining and Retiming

パラ メ ータ : None / Pipelining Only / Pipelining and Retiming 　 デフ ォル ト 値 : Pipelining Only （Diamond 2.1             
までは None）

論理合成中に行 う タ イ ミ ングの最適化処理 [Retiming] と [Pipelining] の実行に関する設定です。

図 6-40. Retiming 処理の一例
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[Retiming] は論理回路を移動させてレジス タ間の負荷を分散させる処理です （図 6-40）。 回路全体に 
対し て この処理が行われます。 これを演算回路等に対し てのみ行 う のが [Pipelining] です。

[None] を選択し た場合、 Pipelining 処理は行われません。 [Pipelining and Retiming] を選択し た場合、  
Pipelining と Retiming 処理が行われます。

[None] を選択し た場合、 どち らの処理も行われません。

Push Tristate

パラ メ ータ : True ／ False デフ ォル ト 値 : True

内部 ト ラ イ ステー ト の論理合成方法に関する設定です。

[True] （デフ ォル ト ） を選択し た場合、 'Z' がレジス タ を介し てポー ト に出力される よ う な記述に対し
て ト ラ イ ステー ト 制御用レジス タ を追加し、 IO バッ フ ァ で ト ラ イ ステー ト 制御を行 う よ う に回路を
論理合成し ます （図 6-41）。

[False] を選択し た場合は、 FPGA 内部で 'Z' が生成されないよ う な回路が論理合成されます。

図 6-41. Push Tristate オプシ ョ ンの効果

Resolved Mixed Drivers

パラ メ ータ : True ／ False デフ ォル ト 値 : False （Diamond 2.0 までは True）

信号の衝突 （Multiple Drive） が発生し ているネ ッ ト の処理に関する設定です。

[True] を選択し た場合、 RTL 上で図 6-42 のよ う に １ つのネ ッ ト が、 複数の ド ラ イバに接続されてお 
り 、 なおかつその中の １ つが [1] または [0] 固定の場合、 論理合成の際にそのネ ッ ト 固定値と し て処
理されます。複数ド ラ イバによ る信号衝突があ る旨の メ ッ セージはロ グに出力されますが、 エラーに
はな り ません。

[False] を選択し た場合、 このよ う な条件でもエラーで論理合成が中断されます。

なお、 どち ら を選択し た場合でも衝突し ている全ての ド ラ イバが固定値でない場合は、エラーで論理
合成が中断されます。

図 6-42. Resolve Mixed Drivers 処理の一例
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Resource Sharing

パラ メ ータ : True ／ False デフ ォル ト 値 : True

リ ソースの最適化処理に関する設定です。

[True] を選択し た場合、 使用する リ ソース を減らすために、 複数あ る同一機能の回路を共有させる処
理が行われます （図 6-43）。

[False] を選択し た場合この処理は行われません。

図 6-43. Resource Sharing 処理の一例

Update Compile point Timing Data

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : False

コ ンパイルポイ ン ト （compile point） オプシ ョ ンを使用し た際の振る舞いに関する設定です。 階層設 
計で compile point 指定されている下位モジュールが変更 ・再度論理合成された場合に、 その上位街道 
のモジ ュールを再合成するか否かを選択し ます。 [False] （デフ ォル ト ） では下位モジュールが再び論
理合成されて も上位モジ ュールは再び論理合成されません。

[True] を選択し た場合、下位モジ ュールが再合成される と上位モジュールが再び論理合成される こ と
があ り ます。 ただし、 上位モジ ュールは必ず再合成されるのではな く 、 下位モジュールの変更によ り
イ ン ターフ ェ イ ス部分の回路構成と タ イ ミ ング （遅延） が変化し た場合に必要に応じ て行われます。

Use Clock Period for Unconstrained I/O

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : False （Diamond 2.1 までは True）

sdc フ ァ イルで制約が与え られていない I/O の制約に関する設定です。

[True] （デフ ォル ト ） を選択し た場合、 制約が与え られていない I/O には "Frequency" オプシ ョ ンで
設定された ク ロ ッ ク周波数の 1 周期がセ ッ ト ア ッ プ時間または Clock-to-Output の制約と し て与え ら
れます。 

デフ ォル ト では制約は与え られません。

VHDL 2008 （Diamond 2.2 以降）

パラ メ ータ : True ／ False 　 　 デフ ォル ト 値 : False

VHDL バージ ョ ン指定のためのオプシ ョ ンです。[True] の場合は、 プロ ジェ ク ト の VHDL 言語仕様と
し て IEEE 1076-2008 を選択し ます。

Verilog Input

パラ メ ータ : Verilog95 ／ Verilog2001 ／ System Verilog 　 　 デフ ォル ト 値 : Verilog2001

コ ンパイルする Verilog HDL の記述仕様の選択です。 デフ ォル ト の [Verilog2001] では IEE1364-2001 
の言語仕様に基づいて コ ンパイルされます。

[Verilog95] を選択し た場合、 IEEE1364-1995 の言語仕様に基づいて コ ンパイルされます。

[System Verilog] は Diamond 2.1 から追加されています。
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6.3.4 Synplify Pro 制約フ ァ イル生成

　 バージ ョ ン G-2012.09 以降 （Lattice Diamond 3.0 以降） は、 ”sdc” フ ァ イルによ る制約設定が ”fdc” （と   
”adc”） を用いる構成に更新されま し た。 従来のレガシー sdc （Synplify Design Constraint） を用いる こ と も可  
能ですが、新規デザイ ンには推奨されません。本節では Synplify Pro が備え る制約エデ ィ タ GUI であ る「SCOPE 
エデ ィ タ」 を用いた ”Synopsis Design Constraint” と し ての fdc （FPGA Design Constraints） フ ァ イルの生成方    
法について、 概要のみを記述し ます。 詳細は Synplify Pro のオン ラ イ ン ・ マニ ュ アル （user_guide.pdf, Chapter  
5） 等を参照し て く ださい。 （なお、 Synplify Pro には sdc から fdc への変換コマン ド ”sdc2fdc” がサポー ト され 
ていますので、 こ ち ら も必要に応じ てオン ラ イ ン ・ マニュ アルをご参照 く だ さい。）

6.3.4.1 SCOPE エデ ィ タの起動と制約の追加方法

　 こ こ では論理合成時に適用する制約フ ァ イルを新規に生成する方法を記述し ます。 RTL の文法エラー等は
すべて解消されている もの と し ます。

　 まず Lattice Diamond から Synplify Pro を単独で立ち上げます。 [File] メ ニューで [New...] を選択し て小ウ ィ   
ン ド ウ を立ち上げます （図 6-44）。 ”fdc” フ ァ イルの生成のため [FPGA Design Constraints] を選択し、 丸印内   
の [New File Name] を入力し て [File Location] をブラ ウズ し て指定し た後、 OK を ク リ ッ ク し ます。 これによ   
り 、 図 6-45 に示すよ う な制約入力用のワーク シー ト 「SCOPE エデ ィ タ」 が立ち上が り ます。

図 6-44. SCOPE エデ ィ タの起動

図 6-45. “FPGA Design Constraints” 入力用ワーク シー ト GUI

　 ウ ィ ン ド ウの下部には複数のタブがあ り ます。 通常はク ロ ッ ク制約を与え る [Clocks] タブや I/O ポー ト に
対する制約の [Inputs/Outputs] タブを選択し た後に、 それぞれを入力し ていき ます。
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　 習熟し ていれば本スプレ ッ ド シー ト 形式のシー ト に直接入力し て構いませんが、 層でない場合の簡単な入
力方法があ り ます。 ク ロ ッ ク ネ ッ ト やポー ト の 「オブジェ ク ト 」 を GUi 上で ド ラ ッ グ＆ド ロ ッ プする方法で
す。 手順は以下の通 り です。

1. Synplify Pro の ト ッ プで左上の大きなボタ ン [Run] を ク リ ッ クするか、 [Run] メ ニューから [Compile 
Only] を選択し てコ ンパイルし ます （図 6-46、 左）。 RTL エラーで処理が完了し ない と次のステ ッ
プができ ませんので、 注意し ます

2. 上部 メ ニューバー内の RTL ビ ューア イ コ ン （図 6-46 の右図に赤枠で示す） を ク リ ッ ク し て、 RTL
スケマテ ィ ッ ク を表示させます

3. 図 6-47 のよ う な、 右上にあ る ”Restore Down” 印 （どの表示でも構わない） を ク リ ッ ク し て、 複数
のウ ィ ン ド ウ間でマウ ス移動ができ る よ う にし ます

図 6-46. コ ンパイル実行 （左） と RTL ビ ューの起動 （右）

図 6-47. 各ウ ィ ン ド ウの個別 （多重） 表示 ”Restore Down”

図 6-48. オブジェ ク ト の ド ラ ッ グ＆ド ロ ッ プ

4. FPGA Design Constraints で Clocks タブを選択し ます （適当な表示位置に移動し ておき ます）

5. RTL ビ ューの左枠で Instances や Nets 項をエ ク スパン ド し て意図する ク ロ ッ ク ネ ッ ト を選択し ます
（図 6-48、 左の赤印が選択された状態）
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6. ク リ ッ ク し た状態でマウ ス を ド ラ ッ グ し て ”Object” セルに ド ロ ッ プし ます （図 6-48、 右）

7. Name や Period （単位は [nsec]） などを入力し ます

8. RTL ビ ューの左枠で各階層で必要な分だけ繰 り 返し ます

　 以上が ク ロ ッ ク制約の設定概要です。

　 I/O タ イ ミ ングについて も同様です。 異な るのはステ ッ プ 4 で選択する タブが ”Inputs/Outputs” であ る こ
と、ステ ッ プ5 で選択するのがポー ト であ る こ と、そし てステ ッ プ7 で入力するパラ メ ータが異な る こ と です。

　 なお、 この fdc フ ァ イルは、 Lattice Diamond のイ ンプ リ メ ンテーシ ョ ン内の Synthesis Constraint File セ ク   
シ ョ ンで Synplify Pro に渡す論理合成制約フ ァ イル と し て取 り 込み、 ア ク テ ィ ベー ト でき ます。詳細は第 2 章 
をご確認 く ださい。

　 また、 Synplify Pro では adc （Analysis Design Constraint） フ ァ イルも定義されていますが、 Lattice Diamond    
を用いる フ ローと し てはその使用を前提と し てお り ません。

6.3.4.2 制約フ ァ イルの Synplify Pro 作業プロジ ェ ク ト への取り込み

　 制約フ ァ イル生成時にプロジェ ク ト にイ ン クルードするかど う かを問われます。 生成が完了し た後、 プロ
ジ ェ ク ト 表示ウ ィ ン ド ウ （Project Files タブ） で図 6-49 のよ う に [Logic Constraints (FDC)] 下や [Analysis    
Design Constraint] にそれぞれフ ァ イル名が表示されていれば、 意図する とお り の動作です。

　 フ ァ イル名が リ ス ト されていない場合は、図 6-50 左のよ う に GUI ト ッ プ左枠内 [Add File...] を ク リ ッ クす  
る と表れる ウ ィ ン ド ウで指定し ます。 この際、 [File of types] 項で拡張子と し て ”*.fdc” を指定し たあ と ブラ  
ウズ し ます （図 6-50、 右）。

図 6-49. 制約フ ァ イル fdc の リ ス ト 表示

図 6-50. fdc フ ァ イルの取 り 込み （1） ブラ ウズ

　 対象フ ァ イルを選択後右下の [Add] ボタ ンを ク リ ッ ク し、 図 6-51 のよ う に意図する操作が終了後に [OK] 
を ク リ ッ ク し て抜けます。 以上によ って図 6-49 と同様にプロ ジェ ク ト に取 り 込まれた リ ス ト 表示にする こ 
と ができ ます。
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図 6-51. fdc フ ァ イルの取 り 込み （2） 指定後 Add し て OK

6.3.5 その他の制約記述

6.3.5.1 コ ンパイルポイ ン ト の設定

　 モジ ュールにコ ンパイルポイ ン ト （Compile point） 設定し て論理合成する と、 コ ンパイルポイ ン ト 毎にデー 
タベースが生成されます。 論理合成を行 う 際にはこのデータベース を参照し、 変更されている ソース フ ァ イ
ルのみの論理合成を行います。 このため、 論理合成時間の短縮にな り ます。

　 コ ンパイルポイ ン ト を設定する場合は、 sdc フ ァ イル内に、 以下のよ う な制約を記述し ます。

define_compile_point {v: ラ イブ ラ リ名 . モジュール名 } -type { コ ンパイルポイ ン ト タ イプ }

　 ラ イブラ リ 名はデフ ォル ト では work です。 コ ンパイルポイ ン ト タ イプは、モジュール間の接続部分の論理
合成に関する設定で、 [soft][hard][locked] のなかから １ つを選択し ます。

図 6-52. コ ンパイルポイ ン ト タ イプによ る最適化の違い

　 [soft] を選択し た場合は、 モジ ュール間の接続分の回路を ま と めて最適化し ます。 [hard] を選択し た場合、
接続部分の回路を コ ンパイルポイ ン ト 毎に個別に最適化を行います。 [locked] を選択し た場合は、 接続部分
の最適化は行われません。
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6.3.5.2 ネ ッ ト リ ス ト の階層展開

　 デフ ォル ト 設定の Synplify Pro では、論理合成後のネ ッ ト リ ス ト をオ リ ジナルの階層を保持し たま ま出力し 
ます。 階層を展開し たネ ッ ト リ ス ト を出力させる場合は、 sdc フ ァ イルに以下のよ う な制約を記述し ます。

define_global_attribute syn_netlist_hierarchy 0

　 この制約は、 HDL ソース内に記述する こ と もでき ます。 記述方法については Synplify Pro のヘルプ ド キ ュ 
メ ン ト を [syn_ netlist_hierarchy] で検索し て く ださい。 なお、 この設定はネ ッ ト リ ス ト の出力に関する設定で、 
論理合成は階層ご と に行われます。

6.3.6 Synplify Pro ヘルプおよびド キ ュ メ ン ト

　 Synplify Pro の使用方法やオプシ ョ ン設定に関するヘルプ ド キ ュ メ ン ト は、 以下のフ ォルダにイ ン ス ト ール 
されています。

[Lattice Diamond のイ ンス ト ールフ ォルダ ]\synpbase\doc

　 Diamond 3.3 をデフ ォル ト 設定でイ ン ス ト ールし た場合 :

C:\lscc\diamond\3.3\synpbase\doc

このフ ォルダには以下の 3 つの ド キ ュ メ ン ト があ り ます。

user_guide.pdf : 主に全体的なデザイ ンフ ローについて説明し た ド キ ュ メ ン ト

reference.pdf : 主に制約設定や特定機能について詳細に説明し た ド キ ュ メ ン ト

release_notes.pdf : バージ ョ ンア ッ プに伴 う 変更点等について説明し た ド キ ュ メ ン ト 　 　

　 また、 Synplify Pro の GUI を立ち上げて [Help] メ ニ ューから [online help] 等を使用する こ と もでき ます。

6.4 Synplify Pro から LSE へのコ ンバージ ョ ン

　 Synplify Pro をプロ ジ ェ ク ト  / イ ンプ リ メ ンテーシ ョ ンの論理合成ツール と し て選択し ていたデザイ ン を   
LSE に変更する際の留意点などを以下に整理し ます。

①タ イ ミ ング制約の確認 ・ 見直し （重要）

　 論理合成ツールが変わる と、 特にタ イ ミ ング制約の対象であ る ク ロ ッ ク ネ ッ ト 名が同一にな ら ない場合が
少な く あ り ません。 同一名でないのは、 例えば ”<clock>_c” のよ う なサフ ィ ッ ク スが異なる と か、 明らかでマ
イナーな違いの場合が殆どですが、 全 く 異なる場合も あ り 得ます。 これら を全て更新する必要があ り ます。

　 まず確認する こ と は LPF に既述 さ れてい る制約が有効かど う か、 です。 スプレ ッ ド シー ト ・ ビ ューで
『Timing Preferences』 タブを選択する と、 有効 ・ 無効が比較的容易に判別でき ます。 当該ク ロ ッ ク ネ ッ ト を 
Primary (Secondary)、 Edge などに指定し ている場合 （『Clock Resource』 タブ）、 また I/O タ イ ミ ング制約の対  
象ク ロ ッ ク と し て指定し ている場合も該当し ますので、 更新し ます。

　 また、 MAP Report の ”Design Errors/Warnings』 項をチェ ッ クする こ と を推奨し ます。

② ”UGROUP” 指定

　 オ リ ジナルで指定し ている UGROUP を一度コ メ ン ト ア ウ ト するな り 、 無効化し て一度 PAR 結果を確認す
る こ と を推奨し ます。 指定無しでタ イ ミ ング等を満たせば、 そのほ う が望ま しい と言えます。 不満足な結果
の場合は、 再度指定を元に戻し、 実行する よ う にし ます。
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6.5 （付録） ス ト ラ テジ ・ オプシ ョ ンの比較

　 本節は両論理合成ツールのオプシ ョ ン比較を示し ます （Ver.3.4 時点）。
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6.6 （付録） LSE サポー ト の HDL ア ト リ ビ ュー ト

　 本節は LSE の対応する ア ト リ ビ ュー ト 一覧を示し ます。
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6.7 変更履歴

--- *** ---

Ver. Date page 内 　 容

2.3F June 30/2014 6-12 6.2.2.2 項 Hardware Evaluation、 IP ラ イセン ス有 り の場合の設定記述を更新

3.1 June 30/2014 6-20 ～ 23
6.5 節 「sdc フ ァ イルの記述」 に代わって 「Synplify Pro の制約フ ァ イル生成」
節と し て SCOPE エデ ィ タによ る方法の説明

3.3 Mar. /2015 all

GUI ダンプ全面更新。 また構成を全面的に変更 ： 6.2 節を LSE、 6.3 節を Syn-
plify Pro と し、 それぞれについてス ト ラ テジ、 制約設定、 等と節の内容を構成
し直し。

6.2.4 Netlist Analyzer 記述追加

6.4 節、 LSE へのコ ンバージ ョ ンを追加

6.5 / 6.6 節付録を追加

3.3.1 (3.3, 
rev1.1)

Apr. 2015 14-15
Netlist Analyzer の 『find』 機能について、 マ ク ロのパラ メ ータ確認について追
記

21 HDL ア ト リ ビ ュー ト 記述例追記
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